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Setup and Installation
This section contains important details related to the planning, configuring, and

installation of your solution. Before you install the solution, familiarize yourself with these

details.

See also:OneStream Solution Modification Considerations

Dependencies

Component Description

OneStream

6.5.0 or later

Minimum OneStream Platform version required to install this

version of File Explorer Manager.

Select the File Explorer Manager Development
Location
Before installation, decide whether to build the solution directly in the Production

OneStream application or in a separate Development OneStream application. This

section provides some key considerations for each option.

Production OneStream Application: The primary advantage of building the solution in
a Production application is that you will not have to migrate the resulting work from a

Development application. However, there are intrinsic risks when making design changes

to an application used in a Production capacity and it is not advised.
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NOTE: OneStream strongly recommends that you implement the solution in the

Development environment with a fresh copy of the Production application before

starting work.

Development OneStream Application: As a best practice, use the Development
OneStream application to build the solution.

Create the OneStream Development
Environment
1. Ensure all the OneStream artifacts relating to File Manager Explorer such as

Workflow Profiles and Entities are in the Production application.

2. Copy your Production application to your Development environment and rename it.

Use the development version for your File Manager Explorer solution.

Server Settings
You may need to edit the OneStream Application Server Configuration so users can

create and change data in the additional database tables. If other OneStream Solutions

(such as Specialty Planning) are already in the application, these adjustments may

already exist.

See also: Solution Database Migration Advice

Configure the OneStream Application Server
Be sure that the security group settings include the users who work on and set up the

solution before proceeding.
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NOTE: Group settings are applicable to all OneStream Solutions; it is important

to keep the group names generic.

1. Start the OneStream Server Configuration Utility as an Administrator.

2. ClickOpen Application Server Configuration File > Database.

3. Edit the followingOneStream Database Server properties:

l Access Group for Ancillary Tables: Select a group that includes those who will
access records.

l Can Create Ancillary Tables: True

l Can Edit Ancillary Table Data: True

l Maintenance Group for Ancillary Tables: Select a group to edit and maintain
tables.

l Table Creation Group for Ancillary Tables: Select a group who can create
tables.

4. Restart Internet Information Server.
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Install File Explorer Manager
1. In the OneStream Solution Exchange, go toOneStream Solutions > File Explorer

Manager.

2. On the File Explorer Manager Solution page, select the appropriate OneStream

platform version from theMinimum Platform Version drop-down list.

3. Select the most recent version from the Solution Version drop-down list and then
click Download.

4. Log in to OneStream.

5. On the Application tab, click Tools > Load/Extract.

6. On the Load tab, locate the solution package using the Select File icon and click
Open.

7. When the solution’s file name appears, click Load.

8. Click Close to complete the installation.

Set Up File Explorer Manager
The first time you run File Explorer Manager you will be guided through the table setup

process: 

l In OneStream, click Community Solution> Dashboards > File Explorer
Manager > File Explorer Manager
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Create Tables and Launch Solution
The first time you run this solution, you are directed to the File Explorer Manager Setup

screen.

NOTE: Before running the setup, ensure that the account being used to access
SQL server has table creation rights on the SQL database to create the custom

tables.

The first step of the setup creates all tables required for File Explorer Manager.

1. Click Step 1: Setup Tables

2. When setup is complete, click Step 2: Launch Solution to open File Explorer
Manager.

Package Contents
The Dashboard Maintenance unit provides the user interface for File Explorer Manager

and includes the required dashboard groups, components, data adapters, parameters,

and files.
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It is not recommended to rename any included Dashboard, dimension, member, etc.

unless specified.

The following Business Rules are included:

FEM_HelperQueries: A Dashboard Data Set business rule. This rule provides helper

queries for listings and reporting statistics used to create the dashboards and provide

activity log functionality.

FEM_SolutionHelper: A Dashboard Extender business rule that provides various helper

functions for the File Explorer Manager solution. These helper functions include

management of the solution setup, configuration settings, file manipulation, and other key

user interactions in the solution.

FEM_ParamHelper: A Conditional Parameter helper functions XFBR String business

rule. This rule is used to provide conditional parameter processing functions that allow a

parameter value to be interpreted and substituted with a different string.

FEM_SharedHelper: A common library of functions and properties that are shared

between the other three business rules. This allows for more consistency throughout the

solution code and the ability to reuse commonly used functions and properties.

The following database tables are included:

l XFW_FEM_Artifact

l XFW_FEM_ArtifactType

l XFW_FEM_Batch

l XFW_FEM_ControlLists

l XFW_FEM_FileContent

l XFW_FEM_FolderFeatures
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l XFW_FEM_History

l XFW_FEM_Operation

l XFW_FEM_Process

l XFW_FEM_Recycle

l XFW_FEM_SystemLocation
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Settings
The Settings page contains the Global Options tab in which key properties that guide

File Explore Manager administration are set as well as User Preferences and Uninstall

options.

Global Options
TheGlobal Options tab allows administrators to:

l Assign a security group to manage File Explorer Manager

l Toggle on/off recycle bin functionality

l Empty the recycle bin of all users

l Assign a recycle bin maximum capacity

Security Role [Manage File Explorer Manager]: This assigned security group permits
access to theGlobal Options settings, Uninstall page, and Activity Log. The default
value for this role is assigned to administrators. If a group lacking administrative
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permissions is assigned to the Security Role [Manage File Explorer Manager], members

of that group will be limited to viewing their respective user folders and will be unable to

restore to folders where they lack the permission to write.

Recycle Bin: The recycle bin defaults to off. When toggled off, deleted files and folders

will be permanently deleted. If toggled on, deleted files and folders will be sent to the

recycle bin granted they do not exceed the recycle bin max capacity.

Recycle Bin for All Users: Clicking the Empty button will prompt the user to confirm that

they want to purge all user recycle bins. This action is permanent. Additionally, the recycle

bins can be emptied using the recycle bin buttons on the main page. These buttons will

display based on whether recycle bins are enabled as well as user permissions.

Recycle Bin Max Capacity (MB): Administrators can set a maximum individual recycle

bin size. Once this threshold is exceeded, files and folders will be permanently deleted

rather than sent to their respective recycle bin. The recycle bin max capacity defaults to

50 MB and cannot be set to exceed 500 MB.

User Preferences
User preferences are settings that are specific to individual users.

User Time: Users can customize the time zone they want to display while using File
Explorer Manager. The default setting is UTC.

The following shows the default time stamp (UTC) in the Time Created and Time
Modified columns in the File Explorer Manager file grid.
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Daylight Savings: Select this box to automatically adjust File Explorer Manager user
time for daylight savings time. Times do not adjust unless this box is selected.

My Recycle Bin: Click Empty to permanently delete the files in your recycle bin. The
number in parentheses shows the total number of files currently in the recycle bin.

Uninstall
The Uninstall tab allows administrators to uninstall the File Explorer Manager user
interface or the entire solution. 

NOTE: If performed as part of an upgrade, any modifications made to the
standard File Explorer Manager objects are removed.

There are two uninstall options:

l Uninstall UI removes File Explorer Manager, including related dashboards and
business rules, but leaves the database and related tables in place. Some Global

Options will also be cleared because their values are stored in Parameters under

Dashboards.

o Choose this option to accept a File Explorer Manager update without

removing the data tables.

o The Release Notes indicate if an overinstall is supported.
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l Uninstall Full removes all the related data tables, all data, File Explorer Manager
dashboards, and related business rules.

o Choose this option to completely remove File Explorer Manager or to perform

a significant update (e.g., database changes or major bug fixes).

NOTE: The File Explorer Manager tables are stored on the application database.
Removing these tables also removes all related File Explorer Manager data for

all applications using the same Framework. This will have no affect on files

located in OneStream's native File Explorer unless they have been moved to the

File Explorer Manager recycle bin.

IMPORTANT: Uninstall procedures are irreversible.
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Use File Explorer Manager
This section focuses on key features of File Explorer Manager and how you can maximize

use of the solution.

Recycle Bin
In File Explorer Manager, the recycle bin is a directory where deleted items are

temporarily stored. When enabled, deleted files or folders are sent to the recycle bin as

long as their addition does not exceed the maximum capacity limit. If artifacts exceed the

maximum capacity, you are prompted to permanently delete these files or cancel the

action.

Restore from the Recycle Bin
The recycle bin helps prevent files and folders from being accidentally deleted. When the

recycle bin is enabled, File Explorer Manager sends files and folders to the recycle bin

where they can be restored.

IMPORTANT: If a file is purged from the recycle bin it is permanently deleted and

cannot be recovered.
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Navigate the Folder Structure
To navigate through the folder tree view, click the arrow to the left of the folder name you

want to expand. Bold folder names indicate underlying folders.

Click on a folder to view its contents in the files grid view.
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Folder Actions
Relevant folder action buttons are displayed based on the folder selected.

Upload File: Displays a dialog box from which you can select a file for upload to the

selected destination folder.

Create New Folder: Displays a dialog box from which you can create a new folder in the

selected destination folder. You are prompted to enter a new folder name, description,

access group, and maintenance group.

Folder Properties: Displays a dialog box from which you can view and modify folder

properties. Editable fields include description, access group, and maintenance group.

NOTE: The ability to edit access group and maintenance group is based on
OneStream user and group security settings. The properties feature is

unavailable in File Share.

Copy: Stores the copied contents in the clipboard. The Paste and Cancel buttons
become visible when you click Copy.
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Paste: After clicking Copy, select the destination folder and click Paste. If you select a
folder to which you do not have write permission, the Paste button is hidden.

Cancel: Cancels the copy action and displays the standard file action buttons.

Delete Folder: When the recycle bin is enabled, deleting a folder sends the folder and its

contents to the recycle bin. If deleting a folder will exceed the recycle bin's maximum

capacity, you are prompted to permanently delete the folder and its contents.

When recycle bin is disabled, deleting a folder permanently deletes the folder and its

contents. A dialog box will prompt you to confirm or cancel the operation.

File Actions
Relevant action buttons are displayed based on the file(s) selected.

Copy/Move: To copy or move files you must first select the files you want to move.
The Paste and Cancel buttons become visible after clicking Copy/Move.

Paste: If you select a folder to which you do not have write permission, the Paste button is
hidden.

Cancel: Cancels the copy/move action and displays the standard file action buttons.

Download: When you select a single item, the Download button becomes visible.

Clicking the download icon from the desktop client opens the selected file. Clicking the

download button from the web client presents a download file dialog box.
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Download (Zip): If you select multiple items, the Download button changes to a Zip
button, which creates a zip file with the selected files. From here you can choose to

extract the files to your desktop, open one file at a time, or save the zip file.

Process (OneStream File Types): OneStream files, such as POV and shortcuts, are

meant to perform specific actions in OneStream and can only be processed one at a time.

Process (Extensible Documents): You can process Extensible Documents by selecting
and clicking the Process button. Multiple Extensible Documents can be processed at

once. When you click the Process button, you are prompted to enter the parameters for

the first file selected. After populating parameters, a new dialog window opens displaying

the Extensible Document. In the top right of the dialog window, a combo box allows you to

toggle between all extensible documents if multiple were selected for processing.
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Activity Log
The Activity Log page is available to administrators and users assigned the Manage File

Explorer Manager security role.

Data in the Activity Log can be filtered, sorted, rearranged, and exported.

NOTE: The Activity Log only tracks actions performed within the File Explorer
Manager solution. Actions taken outside of File Explorer Manager (for example,

from the OneStream integrated File Explorer, Windows File Explorer) are not

captured.
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Actions tracked within the Activity Log include:

l Created

o File Uploaded

o Folder Created

o File Pasted

o Folder Pasted

l Updated

o File Properties Modified

n Description

n Access Group

n Maintenance Group

o Folder Properties Modified

n Description

n Access Group

n Maintenance Group
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l Deleted (Recycled)

o File Recycle

o Folder Recycled

o File Moved

l Restored

o File Restored

o Folder Restored

l Purged (Permanently Deleted)

o File Permanently Deleted

o Folder Permanently Deleted

Column Settings: Column settings can be configured by right-clicking the grid and
selecting Column Setting. Columns can be rearranged and hidden or displayed as

needed.
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Reset State:Right-click the grid and select Reset State to restore column settings to their
default.
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Export: To export the grid list, right-click the grid, select Export, and select one of the
export options below:

l To Excel XML

l To CSV

l To Text

l To HTML

NOTE: The Export feature only exports the information shown in the grid. This
feature does not download files. For more information on downloading files, see

the Folder Actions section.

Manage Grid Items
File Explorer Manager provides several features that let you group, filter, and display the

data, items, and columns in the grid.

Group Grid Items
Column headers can be grouped together by dragging and dropping selected headers to

the dark blue bar above the column headers.
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Column groupings are updated and displayed as soon as the column is dropped into the

bar. When more than one group is used, they will display as nested within higher-level

grouping.

Expand or collapse grouped items by clicking the Expand and Collapse widgets on the
top left of each grouping.

Any column groupings you make are retained between File Explorer Manager sessions.

Groupings remain until they are changed or removed.

To remove a grouping, hover over the column group you want to remove, then click the X
that appears in the group box. You can also click the column group header in the

Grouped by bar and drag it anywhere outside of the bar to remove it. Removing all
groupings restores the list to its original state.

You can also change the list of items within groupings between ascending order and

descending order by clicking the ascending/descending widget on the top of the column

box.

When sorting grid items by multiple groups, you can easily change grouping hierarchy by

dragging and dropping a grouping box to the desired level.

Filter Items Displayed in a Grid
You can use filters in grids to display a subset of the grid's items. This is useful when

working with many items because it allows you to focus on the specific items you need to
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work with.

Column ordering is remembered and retained from session to session until changed.

Any grid with columns that include the Filter button in the column header lets you use

filtering criteria to display the items that meet the defined criteria.

Click the Filter button to display the Filter Criteria dialog.

Select the items to include in the filter. Options are based on specific item values available

in the selected column. You can select all items, specific items, or a single item for

filtering.

Click Filter to apply the filter to the selected task group or task list.

Reorder Grid Columns
Columns in a file grid or report can be moved to customize the order in which they display.

This lets you move the most important columns to the visible area of the grid so you don't

have to scroll to see those columns.

File Explorer Manager Guide xxviii

Folder Actions



To reorder a column in a grid, click and drag the heading of the column to the desired

position in the grid.

File Share Considerations
If the File Explorer Manager solution has more than 1000 file share folders, you may

experience performance issues with longer than normal wait times. .

Enable/Disable File Share Uploads: Enable or disable File Share uploads by going to
OneStream Server Configuration Utility > File >Open Application Server
Configuration File >OneStream Environment > Click Ellipsis > Enable File Share
Uploads.
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System Security Roles: File Share specific security roles can be configured by going to
System > Security > System Security Roles.

Access Group, Maintenance Group, and Description: Due to limitations in File Share,
moving and copying files or folders from the application or system databases to File

Share causes access group, maintenance group, and description to be lost.

Uploading OneStream XML File Types to File Share: OneStream XML file types (for

example, POV, Workflow POV, Shortcuts, Application Settings) cannot be uploaded

directly to File Share.

If you encounter the error below, you must re-upload the OneStream XML file type to the

application or system database, then copy or move the file to File Share.
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Downloading Extensible Documents to File Share: When downloading Extensible

Documents from the application and system databases directly to File Share, you must

use the Download Selected File's Content File button for it to be supported in File Share.

Extensible Documents downloaded using the Download Selected File button are saved in

an unsupported format for File Share usage.

If you encounter an error stating that your Extensible Document is in an unsupported

format, you must re-download the Extensible Document from File Explorer using the

Download Selected File's Content File button.
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File Explorer Manager Best Practices
Save and Close Zip Files: If you download files to a zip and do not close that zip before
attempting to download again, you will receive an error message. Always save and close

open zip folders before attempting to download files to zip again.

Security Group [Manage File Explorer Manager] Role Considerations: The
assigned security group will need to be added as a child to the administrators group to

see the full set of user folders. If an assigned group lacks administrator permissions, the

assigned group will still be able to manage recycle bin functions. However, they will not be

able to see individual user folders and will be restricted to viewing only their own user

folder. If an assigned group does not have write permissions in user folders, they will be

unable to restore files to those folders.
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Help and Miscellaneous Information

This page contains solution documentation.

Display Settings
OneStream Solutions frequently display multiple data elements for data entry and

analysis. Therefore, set your screen resolution to a minimum of 1920 x 1080 to optimally

render forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text

setting to 100% and do not apply any Custom Scaling options.

Package Contents and Naming Conventions
The package file name contains multiple identifiers that correspond with the platform.

Renaming any of the elements contained in a package is discouraged in order to preserve

the integrity of the naming conventions.

Example Package Name: FEM_PV6.5.0_SV101_PackageContents.zip

Identifier Description

FEM Solution ID

PV6.5.0 Minimum Platform version required to run solution
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Identifier Description

SV101 Solution version

PackageContents File name
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Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution

with custom tables such as this one. The relationship between OneStream objects such

as workflow profiles and custom solution tables is that they point to the underlying

identifier numbers and not the object names as seen in the user interface. Prior to the

solution configuration and to ensure the identifiers match within the development and

production applications, the development application should be a recent copy of the

production application. Once the development application is created, install the solution

and begin design. The following process below will help migrate the solution tables

properly.

See also:Managing a OneStream Environment in the Design and Reference Guide.
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OneStream Solution Modification
Considerations
A few cautions and considerations regarding the modification of OneStream Solutions:

l Major changes to business rules or custom tables within a OneStream Solution will

not be supported through normal channels as the resulting solution is significantly

different from the core solution.

l If changes are made to any dashboard object or business rule, consider renaming it

or copying it to a new object first. This is important because if there is an upgrade to

the OneStream Solution in the future and the customer applies the upgrade, this will

overlay and wipe out the changes. This also applies when updating any of the

standard reports and dashboards.

l If modifications are made to a OneStream Solution, upgrading to later versions will

be more complex depending on the degree of customization. Simple changes such

as changing a logo or colors on a dashboard do not impact upgrades significantly.

Making changes to the custom database tables and business rules, which should

be avoided, will make an upgrade even more complicated.
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